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/home/vagrant
├── practicals
│   ├── 01-string-deciphering
│   │   └── 33f46cac84fe0368f33a1e56712add18
│   ├── 02-diffing-cve-patch
│   │   ├── sgdisk-1
│   │   └── sgdisk-2
│   ├── 03-diffing-symbols-porting
│   │   ├── libsensorservice-1.so
│   │   └── libsensorservice-2.so
│   └── 04-firmware-diffing
│       ├── RAX30-V1.0.7.78_1.img
│       └── RAX30-V1.0.9.90_3.img
└── tools
    ├── diffing-documentation
    ├── ghidra_10.3.2_PUBLIC
    ├── idafree-8.3
    └── Sourcetrail

Virtual Machine

Ubuntu 22.04
workshop-bindiff.ova  [   ]

MD5: fcfdbe7710c157dd29007d5064147b39

Size: 5.8 GB
User: vagrant
Pass: vagrant

https://files.quarkslab.com/49cd289f-6dd1-405c-9c19-4d6aff6dccbc/quarkslab-binary-diffing.ova


The Team

Automated Analysis Team @ Quarkslab
(Reverse wide variety of targets and develop tooling to 

assists our security assessment)

Tools

Dynamic Analysis
QBDI dynamic binary instrumentation framework

Qtracer dynamic trace generator and analysis

Symbolic Execution
Triton symbolic execution framework

TritonDSE DSE and exploration library (whitebox fuzzing)

Fuzzing
PASTIS collaborative/distributed fuzzing

HF/QBDI Honggfuzz backed by QBDI

Firmware Analysis
Pandora whole firmware analysis engine

Pyrrha firmware cartography

QSig firmware 1-Day matching engine (discontinued)

Diffing
python-bindiff python library wrapping Bindiff

QBinDiff Binary Differ based on machine learning algorithm

Static Analysis
python-binexport python API to manipulate Binexport files

Quokka IDA plugin and python API to manipulate IDA disassembly

Deobfuscation Qsynthesis synthesis based deobfuscator (targeting MBAs) 33
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The Team

Automated Analysis Team @ Quarkslab
(Reverse wide variety of targets and develop tooling to 

assists our security assessment)

Tools

Dynamic Analysis
QBDI dynamic binary instrumentation framework

Qtracer dynamic trace generator and analysis

Symbolic Execution
Triton symbolic execution framework

TritonDSE DSE and exploration library (whitebox fuzzing)

Fuzzing
PASTIS collaborative/distributed fuzzing

HF/QBDI Honggfuzz backed by QBDI

Firmware Analysis
Pandora whole firmware analysis engine

Pyrrha firmware cartography

QSig firmware 1-Day matching engine (discontinued)

Diffing
python-bindiff python library wrapping Bindiff

QBinDiff binary differ based on machine learning algorithm

Static Analysis
python-binexport python API to manipulate Binexport files

Quokka IDA plugin and python API to manipulate IDA disassembly

Deobfuscation Qsynthesis synthesis based deobfuscator (targeting MBAs)

Today’s
focus
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Workshop Goal

Goal #1
Introducing use-cases and tools (we wrote) to 
speed-up and to automate reverse & diffing 

tasks.

Goal #2
Showing how to do whole firmware diffing.
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Intro
Reverse Engineering

(in a bunch of slides)



Introduction

Can be done on:
● Hardware
● Software (our problematic today!)
● …

Breaking down a system into its core 
component to understand how they 
works.

What is Reverse-Engineering ?  
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Program Representation Levels

Source
Code IR Assembly

(.asm)
Binary

(.elf)

compilation
(frontend)

compilation
(backend)

assembly

disassemblyIR liftingdecompilation

Will work at this level 
(syntactical form)
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Architecture

Architecture

Registers

Registers calling conventionprogram 
counter

stack base/frame
pointer

return
register

x86 eip esp ebp eax
Linux: all parameters on the stack

Windows: (varies)

x64 rip rsp rbp rax
Linux: RDI, RSI, RDX, RCX, R8, R8 +stack

Windows: RCX, RDX, R8, R9 +stack

ARMv7 pc sp r11 r0
Linux: r0, r1, r2, r3

Windows: /

Aarch64 pc sp fp x0
Linux: x0, x1, x2, x3, x4, x5, x6, x7

Windows: /

ISA (Instruction Set Architecture)
Language defining atomic operations that can be done by the processor. Features vary a lot 

from one CPU to the other (vector instruction, floating point, cryptography, virtualization..)

⇒ All manipulates common concepts: registers, stack, memory, privilege levels

calling convention is more complex (caller vs callee etc..) 99



Disassembly

⇒ We usually rely on a disassembler for this task:

switch jump table

“val%d\n”
_fp_hw, _IO_stdin_used

data

Code
(Functions)

main

__libc_csu_init

◼ code ◼ data ◼ global csts
◼ strings ◼ pointers ◼ other

8D 4C 24 04 83 E4 F0 FF 71 FC
EC 10 89 CB 83 EC 0C 6A 0A E8
A7 FE FF FF 83 C4 10 89 45 F0
8B 43 04 83 C0 04 8B 00 83 EC
0C 50 E8 C0 FE FF FF 83 C4 10
89 45 F4 83 7D F4 04 77 3B 8B
45 F4 C1 E0 02 05 98 85 04 08
8B 00 FF E0 C7 45 F4 00 00 00
00 EB 23 C7 45 F4 01 00 00 00
EB 1A C7 45 F4 02 00 00 00 EB

CFGs
[...]

..

.
..
.

..

.
...

[...]

..

.

[...]

[...]

..

CG
(Call Graph)

[...]

[...]

..

Bytes

Code discovery
(identifying code, data)

CFG reconstruction
(indirect flow, funs bounds, 

non-returning funs..)

CG lifting
(xrefs, call graph 

computation)

1010



Executable Formats

➤ Container for machine code

➤ Standard format “explaining” the OS how to load and run the machine code

➤ Also defines: an entrypoint, some resources, additional dependencies

What is an executable format ?

⇒ First component to look at before digging into disassembled code

PE
● Windows
● UEFI

ELF
● Linux, Android
● PSP, Playstation..
● many other OSes

Mach-O
● macOS
● iOS, watchOS…

1111



ELF Format

➤ SECTION: ELF partitionning made by 
the compiler to organize statically 
assets in the file

➤ SEGMENT: ELF partitionning made by 
the linker to organize dynamically 
sections in memory (only LOAD segment 
will be in memory!)

1212



Warm-Up: Poll

Assembly (x64, ARM) ?

Format Analysis (ELF / PE) ?

IDA / Ghidra               ?

Python           ?

How familiar 
are you with

1313



Practical #0: ELF manipulation

Using LIEF write a script to retrieve the following 

informations:

➤ Architecture and bitness (32 or 64)

➤ Entrypoint

➤ Whether it is a static or dynamically linked binary

➤ Shared libraries (on which the program rely)

Practical #0

(Can use any ELF programs in the VM)

LIEF

https://lief.quarkslab.com

1414



Scripting RE
Tasks



Scripting the Disassembly

Disassembler API
Run the scripting engine 
within the disassembler 

context.

Exporter
Approach that exports the 

disassembled program in a file to 
process it outside of disassembler.

✓ Usually many features

✗ Not portable across 
disassembler

✓ API independent from 
disassembler

✓ Can be more compact than 
disassembler database (.i64)

✗ Limited features

Study of 
exporters

1616
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Binary Exporters

Binexport Quokka

BinExport

Format used by bindiff now 
maintained by Google Developed by Quarkslab

Binexport Quokka
Disassemblers IDA Pro, Binja, Ghidra IDA Pro, Ghidra (~)

Format Protobuf, SQL Protobuf

Architectures x86, x64, ARM, Aarch64, DEX, Msil x86, x64, ARM, Aarch64, MIPS, PPC

Data exhaustiveness ~ +++

Export file size ~ ++

Comparison
with Quokka

17 17

https://github.com/google/binexport
https://github.com/quarkslab/quokka
https://blog.quarkslab.com/quokka-a-fast-and-accurate-binary-exporter.html


Binary Exporters: Installation

Binexport Quokka

Pl
ug

in
s

Py
th

on
 A

PI

1. Download the latest release
2. Unpack in the plugin directory
3. Ready to use

1. Download the latest release
2. Unpack in the plugin directory
3. Ready to use

(more documentation) (more documentation)

There is no built-in Python API to 
manipulate Binexport files!

⇓
(so we wrote it)

https://github.com/quarkslab/python-binexport

$ pip install python-binexport

$ pip install quokka-project

1818

https://github.com/google/binexport/releases/tag/v12-20230515-ghidra_10.3
https://github.com/quarkslab/quokka/releases
https://github.com/google/binexport#installation
https://quarkslab.github.io/quokka/installation/
https://github.com/quarkslab/python-binexport


Exporting an Executable

Binexport Quokka

UI
Py

th
on

IDA: Edit > Plugins > Binexport
Ghidra: File > Export Program >

      Binexport (v2) format

from binexport import ProgramBinExport

p = ProgramBinExport.from_binary_file(

    "file.exe")

$ idat64 -OQuokkaAuto:true -A \
  hello.exeSh

el
l

IDA: Edit > Plugins > Quokka  (Alt+A)
Ghidra: File > Export Program >

      Quokka format (not full)

$ binexporter file.exe

(wrapper to call idat64 with the good parameters)

from quokka import Program

p = Program.from_binary("file.exe")

1919

(idat64 not available in IDA Free)



Loading an Export

Binexport Quokka

from binexport import ProgramBinExport

p = ProgramBinExport("myprogram.BinExport")

for fun_addr, fun in p.items():

  for bb_addr, bb in fun.items():

    for inst_addr, inst in bb.items():

      for operand in inst.operands:

        for exp in operand.expressions:

          pass  # Do whatever

from quokka import Program

p = Program("prog.quokka", "prog.exe")

for fun_addr, fun in p.items():

  for bb_addr, bb in fun.blocks.items():

    for inst in bb.instructions:

      for operand in inst.operands:

        pass  # Do whatever

2020



Quokka Cheatsheet

function = program[0x804F7E0] # address known

function = program.get_function("main") # from name

# Find register access (read/write)

from quokka.types import RegAccessMode

instr = quokka.utils.find_register_access(

"eax", RegAccessMode.WRITE, instructions

)  # Find the instruction that writes into EAX

# Call references

call_refs = instr.call_references

address = call_refs[0].address

data = program.read_bytes(address, 8)

# Uses file offset

offset = addr - program.base_address

string = program.executable.read_string(offset)  

# Accessed registers in a instruction

regs_read, regs_write = cpst_inst.regs_access()

Register operations

Cross References (xrefs)

# Data references

data_refs = instr.data_references

address = data_refs[0].address

Accessing functions

cpst_inst = instr.cs_inst  # capstone object

Accessing capstone instruction

block = function[0x804F7E0] # address known

block = function.get_block(0x804F7E0)

Accessing basic blocks

Data access

[     documentation] 2121

https://quarkslab.github.io/quokka/
https://quarkslab.github.io/quokka/


Practical #01: String Deciphering

The binary is a well-known malware which cipher strings used internally.

Tasks:

➤ Export the binary with Quokka

➤ Reverse (manually) to:

○ find the ciphering function
○ understanding the deciphering algorithm

➤ Write a quokka script to decipher all strings

Practical #01

Will need find_register_access and read_bytes on the 
executable object.  

Tip

2222



Solution #01: String Deciphering

⇒ The malware is mirai (first seen in 2016)

ciphered strings in .rodata

⇒

deciphering function calls

cross ref to 
data section

void sub_804F7E0(char *str1,
                 char *str2) {
   int size = strlen(str1);
   for (int i = 0; i < size; 
++i)
       str1[i] = str1[i] ^ 0x37;
  
   size = strlen(str2);
   for (int i = 0; i < size; 
++i)
       str2[i] = str2[i] ^ 0x37;
}

⇒

deciphering pseudo-code

2323



Binary Diffing



Intro Diffing

Use-cases:
→ malware diffing
→ patch analysis
→ anti-plagiarism
→ statically linked libraries identification
→ symbol porting (e.g: IDA annotations to a new version of a binary)
→ backdoor detection (if a program has been modified)

Goal is comparing two (or more) binaries to analyze theirs differences. It usually done on 
functions (1-to-1) mapping computation.
(which can be problematic when functions are merged or split)

Introduction

2525



Differs

Diaphora Bindiff Radiff2 QBindiff

Language Python Java C Python

Disassembler

IDA ✔ ✔ ✘ ✔

Ghidra ✘ ✔ ✘ ✔

Binja ✘ ✔ ✘ ✔

Radare2 ✘ ✘ ✔ ✘

Exporter SQLite Binexport n/c Binexport
Quokka

Scripting API ✔ ✘ n/c ✔

Use decompiler ✔ ✘ ✘ ✘

Homemade (soon 
open-source)

2626

https://github.com/joxeankoret/diaphora
https://www.zynamics.com/bindiff.html
https://r2wiki.readthedocs.io/en/latest/tools/radiff2/
https://github.com/quarkslab/qbindiff


Practical #02: Diffing CVE patch

Diff the two version of the program to understand the CVE patch. 

Methodology:

➤ Export both binaries in BinExport

○ IDA: Plugin > BinExport

○ Ghidra: Export Progam > BinExport

➤ Run BinDiff on the exported files

➤ Open the BinDiff output with: $ bindiff --ui

➤ Identify the code or function affected by the CVE

Practical #02: Manual Diffing

2727



Solution #02: Diffing CVE patch

⇒

Function 
patched!

2828



Scripting Bindiff

Problem
Bindiff made for manual diffing (with UI)

⇓
Thus cannot analyze the diff result in a 

programmatic way

➤ Python API to launch Bindiff on two binaries

➤ Enable scripting the diff result (to analyse it)

➤ Can automate diffing whole filesystem

Python-bindiff 

2929

https://github.com/quarkslab/python-bindiff


Python-bindiff

Light-mode Full-mode

Open diff file (.Bindiff) object and 
provide an API to manipulate it.

Open diff file and map the result on the 
two ProgramBinExport objects.

(slower as requires loading the two files)

from bindiff import BinDiff

# Diff two already exported binaries

diff = BinDiff.from_binexport_files(

    "primary.BinExport", "secondary.BinExport", "output.BinDiff"

)

# Diff from executable (will call IDA Pro and binexport)

BinDiff.from_binary_files("primary", "secondary", "output.BinDiff")

from bindiff import BinDiffFile

# Load a pre-existing BinDiff file

diff = BindiffFile("result.BinDiff")

from bindiff import BinDiff

from binexport import ProgramBinExport

p1 = ProgramBinExport("sample1.BinExport")

p2 = ProgramBinExport("sample2.BinExport")

diff = BinDiff(p1, p2, "output.BinDiff")

Running a Diff

3030



Practical #03a: Scripting Diffing Result

There are two binaries which one is stripped. The goal is to 

automatically port symbols to the stripped binary.

Methodology:

➤ Generate the diff automatically with python-bindiff

➤ Find functions changed/added/remove and output a summary

➤ For matched function add a symbol in the stripped binary

Practical #03a

To add symbols to the ELF use LIEF!

Tip
# List static symbols

binary = lief.parse("./binary")

for symbol in binary.static_symbols:

    pass

# Add new static symbol

sym = lief.Symbol(...)

binary.add_static_symbol(sym) 31 31



Solution #03b: Symbol Porting

from bindiff import BinDiff

import lief

diff = BinDiff.from_binary_files("libsensorservice-1.so",

                                 "libsensorservice-2.so",

                                 "result.BinDiff")

binary_v1 = lief.parse("libsensorservice-1.so")

binary_v2 = lief.parse("libsensorservice-2.so")

# Recover the symbols { func_address : symbol }

symbols = {s.value: s for s in binary_v1.static_symbols}

for match in diff.function_matches:

   if match.address1 in symbols:

       sym = symbols[match.address1]  # Recover the symbol

       sym.value = match.address2  # Update the target address

       binary_v2.add_static_symbol(sym)  # Add the symbol

# Save the patched binary

binary_v2.write("libsensorservice-2-with-symbols.so")

libsensorservice-2.so
(before symbols porting)

(after symbols porting)⇒

3232



Automating
Firmware

Binary Diffing
(batch diffing)



Batch Binary Diffing

Use-Case
Analyzing a firmware update

Problematic
Diffing the whole filesystem

How
Doing batch diffing

3434



Firmware Diffing

1. Firmware Extraction

2. Firmware Cartography

3. Firmware Analysis & Diffing

Extraction
⇒ Complex tasks, the reference is unblob

docker run \
  --rm \
  --pull always \
  -v /path/to/extract-dir/on/host:/data/output \
  -v /path/to/files/on/host:/data/input \
  ghcr.io/onekey-sec/unblob:latest /data/input/path/to/file

Cartography
The goal is having a component overview.

    ⇒ Pyrrha       takes filesystem and maps 
programs and their dependencies
    ⇒ Mostly a GUI to vizualize graphs

pyrrha fs ROOT_DIRECTORY

Analysis & Diffing
Given two rootfs we can:

● Usual diffing on text files
● Automate bindiff diffing of programs

⇒ Explore results to understand changes 3535

https://github.com/quarkslab/pyrrha


Practical #04: Netgear RAX30 diffing

You are given two firmware images for a Netgear RAX30 router. The 
latter is thus an update.
➤ Extract the firmware with unblob
➤ Start exploring extracted files

Practical #04a: Firmware Extraction

Netgear RAX30

➤ Load the first firmware (1.0.7.78) rootfs in Pyrrha 
➤ Find the binaries using curl_easy_setopt

○ search in documentation certificate pinning flag ↗
○ export BinExport executables using this function
○ Script the check for that flag ⇒ identify weak binaries

Practical #04b: Firmware Cartography

➤ Identify (refine) programs that have changed (with hash or other..)
➤ Diff the refined binaries with Bindiff.raw_diffing(p1, p2, out)
➤ Load diffs with BinDiffFile(file) script the analysis
⇒ Can you pinpoint and identify patched vulnerabilities?

Practical #04c: Firmware Diffing

3636

https://gist.github.com/jseidl/3218673
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